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1 Introduction 

The NetApp
®
 Data ONTAP

®
 Edge-T architecture is deployed as a virtual storage appliance on VMware

®
 

vSphere
®
. Data ONTAP Edge-T includes a NetApp Data ONTAP-v operating system to convert a 

vSphere server’s direct-attached storage into a flexible storage platform, providing the same benefits as a 

dedicated NetApp storage system. A Data ONTAP Edge-T instance can be managed through NetApp 

OnCommand
®
 System Manager and the NetApp Virtual Storage Console plug-in for VMware vCenter

™
 in 

the same manner as traditional NetApp storage systems. 

A NetApp Data ONTAP Edge-T storage environment can be configured to provide data recovery to a 

vSphere environment in the event of a system failure through Snapshot
™

 and SnapMirror
®
 Data ONTAP 

technologies. Recovery from a failure can be supported remotely, such as between a field office and a 

central data center, or within the same physical location to accommodate a local recovery. Setup, 

configuration, and use of such a solution, local or remote, is the purpose of this guide.  

Some experience with VMware vSphere, vSphere Client, and vCenter is assumed for the purposes of this 

guide.  

Please note that the NetApp Data ONTAP Edge and NetApp Data ONTAP Edge-T products are distinct 

products. NetApp Data ONTAP Edge-T supports NetApp SnapMirror and SnapVault
®
 primary and 

secondary technologies whereas NetApp Data ONTAP Edge does not. This guide addresses the use of 

the NetApp Data ONTAP Edge-T product. 
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2 Backup and Disaster Recovery Technology 

NetApp Data ONTAP Edge-T and the NetApp Virtual Storage Console provide all the tools necessary to 

build and maintain local backups and a local or remote disaster recovery infrastructure. This guide  

demonstrates how to leverage NetApp Snapshot copies and SnapMirror to preserve data and recover 

from a potential failure with minimal loss of data. 

2.1 Snapshot 

NetApp Data ONTAP Snapshot copies are read-only, point-in-time images of volume data. A Snapshot 

copy is built nearly instantaneously and requires almost no space by using pointers (metadata) to data in 

the volume, rather than making full volume copies. New data is written to new locations within the volume, 

keeping the original data blocks unchanged.  

Restoring data from a Snapshot copy is done by rolling back to the pointers the Snapshot copy recorded 

when it was taken. This results in quick restores that have minimal impact on system performance. The 

full volume can be restored from a Snapshot copy, as can individual files. 

2.2 SnapMirror 

SnapMirror is a NetApp Data ONTAP technology that asynchronously replicates a source volume to a 

secondary volume located on another NetApp controller. The replica is created through a Snapshot copy 

that is copied from the source volume to the target volume; subsequent snapshots are then used to copy 

any data changes. Initially syncing the volumes may take some time, depending on the amount of data, 

but updates tend to be very quick.  

SnapMirror destination volumes are read-only copies of the primary volume and remain read-only until 

the source-to-destination relationship is broken. The destination volumes can be copied or cloned to 

create writable copies of production data for purposes such as testing. The flexibility in the number and 

location of SnapMirror destination controllers, as well as the ease with which replication can be set up 

and executed, makes NetApp SnapMirror a useful component in disaster recovery planning.  

A disaster is generally considered a situation in which part or all of an IT compute environment has failed 

in a manner that impacts the business and the expected time to recover exceeds the maximum tolerable 

outage window. One of the most critical considerations of an IT environment is data integrity. Local or off-

site NetApp SnapMirror replicas of production data can be brought online very quickly to restore critical 

data access to applications and users. 

A SnapMirror disaster recovery plan should not be used as a replacement for a good site backup 

strategy. 
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3 NetApp Data ONTAP Edge-T Installation and Configuration 

To create the local DR solution described in this guide, two instances of NetApp Data ONTAP Edge-T 

must already be installed, and each must be available for configuration and use. 

3.1 Licensing 

All of the features for Data ONTAP Edge-T are included with the purchase price and must be enabled 

individually. To deploy a SnapMirror-based disaster recovery solution, you need to enable the following 

feature licenses, at a minimum: 

 NFS or iSCSI  

 SnapMirror 

 SnapRestore
®
 

Connect to the NetApp Data ONTAP Edge-T virtual appliance with NetApp OnCommand System 

Manager to apply storage feature licenses. To add a feature license, navigate in OnCommand System 

Manager to System Tools -> Licenses and apply licenses through the Add feature. 

Note: These licenses are NetApp Data ONTAP Edge-T licenses. This is different from the NetApp Data 
ONTAP Edge product, which does not support SnapMirror. 
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3.2 Virtual Storage Console Installation 

The NetApp Virtual Storage Console is a VMware vCenter plug-in that manages NetApp storage in the 

vSphere environment. It will be an integral part of the disaster recovery solution and may be installed into 

vCenter at any time. Default installation options can typically be selected. The Backup and Recovery 

option and the software license must be installed to support backing up virtual machines and datastores. 

Install the VSC on an appropriate computer. 
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Also register it through a browser with the vCenter Server. 
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The VSC will be available as a tab in the vSphere client Hosts and Clusters inventory and as an option in 
the Solutions and Applications menu. Navigate to View -> Solutions and Applications -> NetApp and, in 
the Monitoring and Host Configuration tab, add the NetApp Data ONTAP Edge-T instances as Storage 
Controllers. 

 
If not already set, the VSC can also configure the adapter, MPIO, and NFS settings of the vSphere hosts 
by right-clicking the host and selecting Set Recommended Values. Remember to do this as additional 
vSphere hosts are added to the vCenter server. 
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4 Datastore Provisioning and VM Deployment 

4.1 Create an NFS Datastore 

In the vSphere client, highlight the data center and open the NetApp -> Provisioning and Cloning -> 
Provision Datastore menu. 

From the Datastore Provisioning Wizard, select the target storage controller. 
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Select the NFS datastore type and define the datastore size, name, NetApp Data ONTAP Edge-T 

instance aggregate, and thin-provisioning details (if chosen). Confirm the configuration and commit. 
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Select a vSphere server and open the Configuration tab, Storage window. The new NFS datastore will be 

visible in the datastore listing. 
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4.2 Create an iSCSI Datastore 

In the vSphere client, highlight the data center and open the NetApp -> Provisioning and Cloning -> 

Provision Datastore menu. From the Datastore Provisioning Wizard, select the target storage controller. 
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Select the VMFS datastore type, choose the iSCSI protocol, and define the datastore size, name, target 

volume (or have a volume be created automatically), NetApp Data ONTAP Edge-T instance aggregate, 

and thin-provisioning details (if chosen). Confirm the configuration and commit. 
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Select a vSphere server and open the Configuration tab, Storage window. The new iSCSI datastore will 

be visible in the datastore listing. 

 

4.3 Provisioning Virtual Machines or Applications 

Virtual disks are created as with any other VMware datastore and provisioned for the creation of virtual 

machines or attached to VMs as application storage. 
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5 Set Up Disaster Recovery Relationships and Replication Schedule 

5.1 Configure SnapMirror Relationships Between Source and Destination 

The SnapMirror source-to-destination volume relationship is configured with NetApp OnCommand 

System Manager 

Using OnCommand System Manager, update /etc/hosts on the source and destination NetApp Data 

ONTAP Edge-T instances by opening Configuration –> Network -> Network Files from the menu bar and 

adding the IP address and host names of both instances to /etc/hosts. 
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Now, from the source Data ONTAP Edge-T instance, navigate to the SnapMirror menu option to set up 

remote access between the source and destination Data ONTAP Edge-T instances. Select the Remote 

Access option in the SnapMirror window to open the Remote Access configuration tool. Add the 

destination Data ONTAP Edge-T instance. Selecting the All_volumes option for Volume or Qtree will 

simplify the setup. 

 

 

 

 

 

Repeat the remote access configuration from the secondary Data ONTAP Edge-T instance, this time 

granting access to the source instance. 
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After remote access is configured it’s time to set up the source volume–to-destination volume 

relationship. Select the Create option to open the SnapMirror Relationship Create Wizard. This can be 

done from either the source or the destination instance and does not need to be repeated on the other 

instance. 
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Select the volume to be replicated and the SnapMirror destination storage system. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A target volume needs to be established on the destination system. The wizard will create one if none 

exists. The target volume needs to be the same size as the source volume for an NFS datastore and 

slightly larger for iSCSI. 
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SnapMirror can be executed on demand or scheduled. There are valid reasons to use either approach. If 

SnapMirror updates will be initiated from the NetApp Virtual Storage Console as part of a local backup 

policy (discussed later in this guide), an on-demand schedule may be appropriate. Otherwise, the wizard 

can be used to set up a schedule. 

The option to Initialize SnapMirror relationship is available, which will simply create the first 

snapshot and copy to the destination Data ONTAP Edge-T instance. If that option is not selected now, a 

manual initialization will have to be executed at a later time 

 

A Data Transfer Rate should be defined if there is any concern about flooding the network bandwidth 

from the initial sync and subsequent updates. Unless there is a great deal of data continually written to 

the datastore between SnapMirror updates, updates don’t tend to be as significant as the initialization. 
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Confirm the SnapMirror configuration between the source and destination for the volume selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The final screen of the wizard is an acknowledgement that the SnapMirror relationship has been 

established and, if selected as an option earlier in the process, the confirmation to begin the SnapMirror 

initialization. The initialization may take some time, depending on the size of the datastore and the 

condition of the network between the source and destination. 
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If an initialization was not executed when the SnapMirror relationship was created, it can be executed 

from the Operations menu. When complete, the SnapMirror window in NetApp OnCommand System 

Manager will display the summary and details about the most recent SnapMirror replication. 

The SnapMirror relationship creation and initialization process is the same regardless of whether the 

NetApp Data ONTAP Edge-T–provisioned datastores are NFS or iSCSI/VMFS datastores. 

5.2 Configure Virtual Storage Console for Backup Support 

Configuring SnapMirror between two or more NetApp Data ONTAP Edge-T instances is technically 

sufficient to provide disaster recovery potential. However, the NetApp Virtual Storage Console offers 

additional tools and features to improve the robustness and usability of this DR solution. The backup and 

recovery features of the VSC offer additional options to sync source and destination volumes and 

manage Snapshot copies beyond those of the tools provided by vSphere. 
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Assuming that the NetApp Virtual Storage Console was installed and licensed with the Backup and 

Recovery option, add the NetApp Data ONTAP Edge-T primary instance as a storage controller to the 

Backup and Recovery feature. 

In the vSphere client, navigate the View menu to Solutions and Applications -> NetApp. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open the Backup and Recovery tab, proceed to the Setup window, and add the NetApp Data ONTAP 

Edge-T instance that supports the existing datastores and virtual machines. This will allow the VSC to 

manage Snapshot backups of datastores deployed on these instances. 
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Note: Backups taken through the VSC plug-in can be configured to initiate a SnapMirror update once 
the source-to-destination volume relationships are established. This functionality will be explained 
in the following section. 
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6 Using NetApp Data ONTAP Edge-T and Virtual Storage Console 

Backup and Recovery to Facilitate Disaster Recovery 

6.1 Configure Local Backup Policy with the Virtual Storage Console 

Open the Backup and Recovery tab of the VSC. Navigating to the Backup window provides an interface 

to configure datastore backups. Clicking on the Add tab brings up the datastore Backup Wizard wherein a 

datastore backup policy is defined. 

Note the option to initiate a SnapMirror update. If selected, the SnapMirror destination will be synced to 

the source as part of the backup. This can be used in place of defining a schedule as part of the 

SnapMirror configuration and may be appropriate for backups that require an application to be quiesced. 

The Backup Wizard will assist with selecting the datastore(s) to be backed up. 
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Any custom scripts designed to be run simultaneously with the backup can be included in the policy, with 
the backup schedule defined and credentials confirmed. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Backup retention and event notification e-mail addresses are added. 
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The backup configuration is confirmed and approved to create a local backup of the datastore(s) on the 

NetApp Data ONTAP Edge-T instance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Datastore Snapshot copies are synced to the SnapMirror destination either when taken (if defined that 

way in the backup configuration) or on the schedule created when the SnapMirror relationship was 

established. In the event that a disaster recovery procedure is implemented, the SnapMirror destination 

will be in sync with the most recent Snapshot copy. 

 

6.2 Backup Policy Considerations 

Best practices for system and application backups are highly dependent on the type of data and 

applications deployed. Many resources exist on this topic, including the documentation available for most 

enterprise applications. It is not this guide’s purpose to recommend specific backup policies for all 

potential virtual machine and application environments. However, some general considerations are 

offered here. 

The simplest, and generally the easiest, backup policy to restore from is an offline backup, with 

applications and virtual machines in the datastore shut down. This is a good choice for a baseline backup 

after a virtual machine and applications are initially installed. Since a Snapshot backup is a very quick 

procedure, the VM does not need to be offline for long. Periodic offline backups are a good policy if the 

environment and application demands can support it. 

However, many production application environments are not intended to be shut down on a regular basis 

and will therefore have to be backed up live. When backing up live applications, data consistency may be 

a concern when data is very dynamic. A Snapshot backup may or may not preserve the correct data 

states and relationships to allow a good application restore. For example, a file server may experience no 

problems restoring from a backup taken while the system was live whereas a database may see 

consistency errors between data and logs resulting in unrecoverable data corruption. 

Hot backup utilities exist for many applications and software products. Backup policies created through 

the VSC should take application backup windows into consideration to minimize data loss in the event of 

a data restore.  

In dynamic environments, frequent backups can minimize data loss. Snapshot copies easily support 

frequent backups since Snapshot copies are quick and use little space to update pointers. Because of 
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this, syncing the SnapMirror destination tends to be a quick process as well. There are limits on the 

maximum number of Snapshot copies, so a backup retention policy should be considered. If data 

changes less frequently, fewer incremental backups are needed. It is important to know the nature of the 

application and data before defining backup policies.  
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7 Disaster Recovery Step-by-Step Execution  

7.1 Prepare vSphere and NetApp Data ONTAP Edge-T for Recovery 

Disaster recovery procedures should be implemented once it is confirmed that an outage cannot by 

corrected within the service-level-agreement window and that the time to recover the primary servers or 

datastores will exceed the time required to bring the secondary systems online. 

 

From VMware vCenter
™

, remove the NetApp Data ONTAP Edge-T instance and the failed VMs from the 

vCenter inventory. 
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With the VMs removed from the inventory, it is possible to remove the failed datastores from the vSphere 

host. Rescan the storage adapters when done. 

 

If a new vSphere server is also needed for recovery, add it to the vCenter inventory. 
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Open the secondary NetApp Data ONTAP Edge-T instance in NetApp OnCommand System Manager. 

Navigate to the SnapMirror window and break the SnapMirror relationships to make the replica volumes 

writable. 

Note: If the primary volume is still online (in a testing scenario, for instance), the SnapMirror relationship 
should be quiesced before being broken so that no active transfers are in progress. 

If the SnapMirror break doesn’t take effect, it may be necessary to use the Data ONTAP command line to 

perform these steps. Log onto the secondary NetApp Data ONTAP Edge-T instance with a console tool 

as the root user and execute the following: 

 # snapmirror quiesce volume_name 

 # snapmirror break volume_name 

 

The process for completing the recovery of a SnapMirror datastore will differ depending on whether the 

datastore is an NFS or iSCSI volume. 
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7.2 Recovering an NFS Datastore 

With the SnapMirror relationship broken, the NFS volume is now writable. In OnCommand Manager, 

navigate to the NFS Exports window and verify that the vSphere host is included in the export rules. If it is 

not included in the existing rules, add the host and grant it root access to the share. 
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Return to vCenter and add the SnapMirror destination volume as a new NFS datastore to the vSphere 

host. 
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7.3 Recovering an iSCSI Datastore 

With the SnapMirror relationship broken, the volume holding the iSCSI LUN is now writable. Open 

OnCommand System Manager and connect to the NetApp Data ONTAP Edge-T secondary instance. 

Navigate to the LUNs window. Select the SnapMirror LUN and edit its properties to create an iSCSI 

initiator group with the desired vSphere host.  

Note: The VMware iSCSI initiator name is found in the vSphere client Configuration tab, Storage 
Adapters window, of the vSphere host. 

 

 

 

 

From the Create Initiator Group Wizard, General tab, provide a name for the initiator group, choose 

VMware for the operating system type, and iSCSI as the protocol. Switch to the Initiators tab to add the 

vSphere host initiator name. Click Create to build the initiator group and close the Create Initiator Group 

Wizard. 
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Note: Several vSphere host iSCSI initiators can be placed in the same group for ease of 
management. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Now select the initiator group and, optionally, provide a LUN ID. Save and close the wizard. 
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The replica LUN is now ready to be mapped to the vSphere host as a datastore. In vCenter, select the 

host and navigate to the Configuration tab, Storage Adapters window. Select the iSCSI Software Adapter 

and open its Properties.   

In the Discovery tabs, verify that the NetApp Data ONTAP Edge-T secondary instance and its iSCSI 

target name are listed. This may already be done if the VSC was previously used to configure storage 

adapters. If not, add them manually. 

Note: The NetApp Data ONTAP Edge-T iSCSI target name can be found through OnCommand 
System Manager in Configuration -> Protocols -> iSCSI. 
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Rescan the storage adapters and open the Configuration tab, Storage window, to add the SnapMirror 

replica LUN as a new Disk/LUN. The Add Storage Wizard will recognize the LUN as an existing VMFS 

volume. Be sure to select the option to assign a new signature to the volume, or it will not be 

writable. 
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7.4 Recovering Virtual Machines and Applications 

Once the datastore replicas have been added to the vSphere host, virtual machines can be recovered to 

the state of the most recent backup. 

In vCenter, highlight the vSphere host, navigate to the Configuration tab, and open the Storage window. 

Select a datastore containing a VM to be recovered, right-click it, and select Browse Datastore. 

Open the folder for the VM to be restored and right-click the virtual machine file. It will have a .vmx 

extension. Select Add to Inventory. 
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The Add to Inventory Wizard will appear. Select the appropriate vSphere host and confirm. When the VM 

is powered on, the vSphere client will display a message that the VM may have been moved or copied. 

Confirm that it was copied and the VM will complete powering on. 
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7.5 DR Final Steps 

In a best-case scenario, the disaster recovery environment of a NetApp Data ONTAP Edge-T instance is 

local and the same vSphere hosts are used for the recovered VMs. In this case there is little concern 

about properly scaling VMs to fit the vSphere server resources. However, if different vSphere servers are 

used to host the recovered VMs, it’s possible that those servers are not scaled identically to the original 

ones or they may already be hosting other VMs. In that case, the VM administrator must review VM 

scaling before powering on any new VMs. 

If a DR failover environment is going to be run for any length of time, it is critical to verify that proper data 

protection is put in place. VM and datastore backups must be reinstated to maintain data integrity. Plans 

should be made to either roll back to the original NetApp Data ONTAP Edge-T instance, when it is 

recovered, or prepare a new disaster recovery environment.  
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8 Roll Back to Source Datastore and Servers 

There may be acceptable reasons to maintain a disaster recovery instance of NetApp Data ONTAP 

Edge-T as the new primary site. However, disaster recovery is typically intended to be a short-term 

solution and a rollback to the original, primary instance will be implemented once that instance is 

recovered or replaced.  

8.1 Change Datastores with VMware Datastore Migration 

To roll back simply and with minimal impact on running applications, use VMware’s migration tools. 

In vCenter, add the vSphere host with the new or recovered NetApp Data ONTAP Edge-T instance and 

reregister that instance with the Virtual Storage Console. Recreate datastores to the original 

specifications. 

Right-click the VM to be moved to the new datastore and select Migrate. 
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In the Migrate Virtual Machine Wizard, select Change datastore and choose the appropriate datastore as 

the destination.  

Note: It is also possible to migrate a live VM to a new vSphere host if vMotion
®
 is enabled on the 

vSphere servers. 
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When the VM migration completes, reestablish the SnapMirror relationships between the primary and 

secondary volumes and redefine the datastore and VM backup policies. 
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Appendices 

NetApp Data ONTAP Edge-T Disaster Recovery Setup Checklist 
 

□ Register NetApp Data ONTAP Edge-T primary and secondary instances with vCenter and the VSC. 

□ Edit /etc/hosts of NetApp Data ONTAP Edge-T primary to reference secondary.  

□ Edit /etc/hosts of NetApp Data ONTAP Edge-T secondary to reference primary. 

□ Edit /etc/snapmirror.allow on NetApp Data ONTAP Edge-T primary to reference secondary. 

□ Edit /etc/snapmirror.allow on NetApp Data ONTAP Edge-T secondary to reference primary. 

□ Enable SnapMirror remote access on NetApp Data ONTAP Edge-T primary and secondary. 

□ Create SnapMirror source-to-destination relationship for each volume to be replicated. 

□ Create SnapMirror schedule (or leave as On Demand and update with VSC backups). 

□ Perform SnapMirror initial sync. 

□ Register NetApp Data ONTAP Edge-T primary in VSC Backup and Recovery tab. 

□ Create backup policy through VSC for each datastore. 
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NetApp Data ONTAP Edge-T Disaster Recovery Implementation Checklist 
 

Break SnapMirror relationship 

□ Remove offline NetApp Data ONTAP primary from vCenter inventory. 

□ Remove offline VMs from vCenter inventory. 

□ Delete offline datastores from vSphere hosts. 

□ Quiesce and break SnapMirror relationship between source and destination volumes. 

 

Recovering an NFS datastore 

□ Update NFS exports for destination volume to include vSphere host and root access. 

□ Add destination volume to vSphere host as new NFS datastore. 

 

Recovering an iSCSI datastore 

□ Edit destination iSCSI LUN to add iSCSI initiator for vSphere host. 

□ Map destination iSCSI LUN to vSphere iSCSI initiator. 

□ Verify that the vSphere host iSCSI software adapter is configured with the NetApp Data ONTAP 

Edge-T secondary’s address/host name and iSCSI target name. 

□ Add destination iSCSI LUN as datastore to vSphere host. 

□ Assign new signature to volume. 

 

VM and application recovery 

□ Browse datastore for VM folders. 

□ Select virtual machine file (.vmx) from VM folder and add to vCenter inventory. 

□ Adjust VM scaling if recovering on new vSphere hosts. 

□ Update VM and datastore backups. 

 
 
Roll back to primary datastores and server 

□ Recover or rebuild NetApp Data ONTAP Edge-T primary.  

□ Add NetApp Data ONTAP Edge-T primary vSphere host to vCenter. 

□ Register NetApp Data ONTAP Edge-T primary with the VSC. 

□ Rebuild primary datastores on vSphere hosts. 

□ Using VMware, migrate utility, move VMs back to primary datastores. 

□ Reestablish SnapMirror source-to-destination relationships and backup policies. 
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NetApp provides no representations or warranties regarding the accuracy, reliability, or serviceability of any 
information or recommendations provided in this publication, or with respect to any results that may be 
obtained by the use of the information or observance of any recommendations provided herein. The 
information in this document is distributed AS IS, and the use of this information or the implementation of 
any recommendations or techniques herein is a customer’s responsibility and depends on the customer’s 
ability to evaluate and integrate them into the customer’s operational environment. This document and  
the information contained herein may be used solely in connection with the NetApp products discussed  
in this document. 
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